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Agenda
• Finishlynx System Overview
• Set up with one, two or more computers
• Basic configuration guidelines
• Three Easy Steps: Capture, Evaluate, 

Print
• Making it easier by using Files
• What Can Go Wrong?
• After the Meet is over
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Finishlynx – What is it?

• What Finishlynx Does
– Electronic timing for track and cross country 

events.
– Accurate times to 4 decimal places (1/10,000 

of a second)
– Provides Finish times, place info, and race 

results
– Supports multiple cameras, scoreboards, split 

times, and more
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Finishlynx – What is it?

• What Finishlynx Doesn’t Do
– Not a full-featured race management system
– Does not manage meet entries – no “clerk of 

the course” features
• (athlete/school/events/etc)

– Does not do any scoring
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Finishlynx – How It Works
• Not your normal digital camera
• Takes very narrow “frames” (1/8th to 1/4th of an 

inch wide)
• Each frame is assigned a time by the camera
• Frames are “glued” together to form a composite 

image that you see on the screen.
• Can capture and evaluate at the same time
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Finishlynx – How It Works
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Finishlynx – The Picture

Why is the background white??
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Finishlynx – Installing Software

• Software available at www.finishlynx.com
• Don’t forget the plug-ins
• No support contract – upgrades are free!
• All components use different activation 

keys (serial numbers)
• Step 1 each year – install new software
• But first…
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Finishlynx – Installing Software
• Write down configuration 

info before upgrading
– Updates reset all config 

parameters
– Serial numbers are in the 

Help->About box
• Maybe install each 

version in a different 
location instead of default 
location.
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Setup – One Computer
Power

Power

Antenna

Finishlynx “Connection Box”

CAT-5 
network 
cables
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Setup – Two Computers
Power

Power

Antenna

Finishlynx “Connection Box”

CAT-5 
network 
cables

Power
Power

Power

Network Hub
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The Basic Finishlynx Screen

Remote Positioner 
Controls

Always “center” first 
before aligning camera

“Tool Tips” are shown here
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The Other Basic Screen

“Event” pane
“Results” pane

“Image” pane
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Aligning the Camera

Demonstration
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Pre-Race Software Setup

Things to do before any meet
• File->Options

– Actually, anything->Options
– 8 tabs, 5 important

• Camera Options
– 6 tabs, 5 important
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General Options
• Name of Event

– Los Altos vs. Lynbrook

• Sponsor
– Printed on all results
“Visit www.lynbrooksports.com”

• Port for Capture Button
– Only lists valid ports

• Let it detect the camera 
type
– If multiple computers, set this 

for capture system only – use 
none for others
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Event Options
• Single Event mode to “On”

– “off” if you’re really, really good

• Default Template
– Suggest leaving blank

• File naming
• Where your saved files will go
• Backup directory

– Can be different than event 
directory

– Maybe a USB thumb drive
– File->Backup
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Image Options
• Enable all toolbar items
• Lane Bars on both sides
• Use defaults for other 

items
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Results Options
• Enable all toolbar items
• Choose fields to list

– Defaults OK

• Default Precision to 
“hundredths” (2 decimal 
positions)

• Use default “round up” 
method
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Database Options
• Use “Files”
• Use “ten thousandths”

– Controls what’s in the LIF file

• Where to look for .evt 
file and .ppl file
– Use same directory as event 

directory

• Where the LIF files are 
written

• “Off” for capture, “On” 
for evaluate system
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Camera Settings
• Used to control “camera 

specific” options
• If it isn’t on normal 

“options” windows, it’s 
probably here.

• Found under the “Blue I”

These parameters can only 
be changed between 
races!
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Camera Setup Tab
• Which way are the 

runners going?
• Race-specific

– Can be overridden later

• Controls “lane bars”
– And which lane is at top of 

picture

• Set to zero, then do 
white balance
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Camera Parameters
• Start with defaults
• Gain – how much 

electronic “boost” to 
the picture.
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Camera Inputs
• Using RadioLynx

– Set to “none”

• Using “Wired” starter
– Set to “closed” or what is 

listed on the sensor (look 
for “NC” or “NO”)

• If not “None” AND you 
are using wireless 
sensor, you will see 
“some sensors failed to 
arm” when setting up a 
race
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RadioLynx
• Set to “Connection 

Box” to enable 
wireless start

• Set to “Start Sensor”
• Default other values

• If using multiple systems, can 
use setup ID and mask to 
eliminate confusion (older RL 
units only)
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Capture Options
• Suggest “Manual” at 

first
• “Automatic” isn’t so 

automatic – have to 
enable during the 
race
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Three Easy Steps

1. Capture
2. Evaluate
3. Print

What can be so hard?
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Timing an Event – The Steps
1. Set up the event and “arm” the system
2. Signal starter that you are ready
3. Wait for gun. Verify that clock has started
4. Capture finishers as they cross finish line
5. Save the file
6. Evaluate the results and print
7. Save the file
8. Lather, rinse, repeat…(or capture, evaluate, 

print)
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Step 1 – Set Up the Event

Step 2 – Signal Start You Are Ready
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Step 3 – Verify Start of Race

The clock is 
running

No longer 
“armed”

Start time inserted
(based on computer’s clock)
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Step 4 – Capture The Finishers

Step 5 – Save the file!

In manual capture mode, 
press button as each runner 

approaches finish line
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Step 6 – Evaluate Results

7. Print the results
8. Save the file again!
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Step 7 – Print The Results
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Easy! What Could Go Wrong??

• Setup and Configuration Errors

• “Run Time” Errors
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Setup Errors
• Capture Button error when starting Finishlynx
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Setup Errors
• Capture Button fix:



• Start Sensor Errors
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Setup Errors

OR



Start Sensor Fixes

Feb 17, 2013 Finishlynx Essentials 38



“Run Time” Errors
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• Clock starts before the gun goes off
– Usually the starter bumps start sensor

• Gun goes off, but the clock doesn’t start
– Transmitter not turned on
– Transmitter not charged
– Starter not holding sensor properly
– Receive antenna close to metal objects

All of these are considered “false starts”.
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Clock Starts Before Gun Fires

Two solutions based on time available
1. If time available (gun not up), click on the big traffic signal – this just 

resets everything. 

2. Gun up (real start immanent). Wait and assign correct start time.
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1) Re-Arm The Event
• If time permits:
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1) Re-Arm The Event
• If time permits:
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2) Assign The Correct Start Time
• “Real” start is about to happen
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Missed Start Signal
Gun goes off, but no start detected
• Question 1: Were you typing at the start?

– Keyboard entry “holds off” start until you’re done 
typing – just hit enter a couple of times.

• Nothing you can do on the system
• Signal “false start” to starter (gun, horn)

– Check connections
– Gently tap start sensor to create a signal 
(Should have tested this before the first event!)
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Hints / Good Practices

• Pay attention!
– Watch actions of starter and start line. As they 

set in the blocks, check the clock.
– When the gun’s up, watch the clock and have 

air horn in your hand
• Use a customized sound file for starts

– Rename your favorite .wav file to 
finishlynxstart.wav (keep it short)

– Turn volume up!
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Play Time and Questions

• Set up an event
• Create a “start”
• Capture something
• Evalute
• Save

Any Questions??
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Important FinishLynx Files

• Used to ease the typing task
• Plain ASCII files but don’t end in .txt

– (use Notepad or Textpad to edit/create)

• Commas separate fields (don’t put 
commas in names like Smith, Jr.)

• Stored in the events directory
• “Weird” behavior if you get the commas 

wrong
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Lynx.evt – The Event File
• List running events, usually in order
• Can list entries (seeded race)
• Format:
Event#,round#,heat#,event_name
001,1,1,VG-400-R
002,1,1,VB-400-R
002,1,2,VB-400-R

Hint: Add extra entries for races known to have more than one 
heat (main dashes).
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Lynx.sch – the Schedule File
• Optional – don’t use it
• Lists events in schedule order
• If present, overrides order in Event file
• Format:
Event#,round#,heat
012,1,1
002,1,1
• Be careful if you use Meet Manager!
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Lynx.ppl – the People File

• Lists every possible running competitor
• Used to assign “competitor numbers” to names
• When evaluating, use competitor number 

instead of typing full name/school, etc.
• Format:
ID,last_name,first_name,school

2001,Anderson(10),Tyler,Los Altos
8001,Anderson(9),Marcus,Palo ALto
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Lynx.ppl Hints
• ID does not have to be numeric – 200A works
• Enter extra entries for relay races
2000,Los Altos,Los Altos,Los Altos
2999,Los Altos,Los Altos,Los Altos

• When evaluating, use competitor number 
instead of typing full name/school, etc.

• Can only enter ID once per race!
• Develop a numbering plan that works for your 

environment
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Why Use Files?

• Speeds up results, requires less people
• Can evaluate by Competitor ID instead of 

typing full name/school information.
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How To Change Evaluation 
Method

Global Setting Event-specific setting
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FinishLynx Files Demo



Feb 17, 2013 Finishlynx Essentials 55

What Else Can Go Wrong?
• Missing/Wrong Competitor/ID Number
• Wrong name info shows up on evaluations
• Evaluated using wrong competitor number
• Captured a lapped runner
• Missed capturing a runner
• Bizarre finish times (minutes for 100 meters)
• Captured using wrong event
• No sensors working
• Capture button doesn’t work
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What Can Go Wrong?

Missing/Wrong Competitor/ID Number

• Look at the lynx.ppl file
– Competitor # missing or typo
– Wrong number of parameters
– Duplicate competitor number
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What Can Go Wrong?

Wrong name info shows up on evaluations

• Look at the lynx.ppl file
– Duplicate competitor number
– Wrong information
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What Can Go Wrong?
Evaluated using wrong competitor number

(* don’t use “delete result” if you have a seeded race – (advanced topic)

Captured a lapped runner
– Skip over the extra runner – no biggie
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What Can Go Wrong?

• Missed capturing a runner
– Fudge
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What Can Go Wrong?

Bizarre finish times (minutes for 100 meters)
• The start time is wrong – pick the different 

start time from the list. You may have to 
try a few times – maybe you missed the 
start (pay attention).

• This takes time and can only be done on 
the capture system (fixed in 8.0)



Feb 17, 2013 Finishlynx Essentials 61

What Can Go Wrong?
Captured using wrong event
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Fixing the Wrong Event Problem
Stop and take your time. Delay the next race if necessary – you need to get
this right otherwise you can lose race information.



Feb 17, 2013 Finishlynx Essentials 63

Fixing the Wrong Event Problem
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What Can Go Wrong?

• No sensors working
• Capture button doesn’t work

– Use keyboard start work-around buttons.
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What Else Can Go Wrong??

• Lots
– Power, batteries in laptops
– People on the track in camera’s view (auto capture)
– Camera gets bumped
– Electronic starter not fully charged
– Static electricity on artificial fields!  Zap!
– No paper, no toner/ink
– Lack of patience
– <your hot item goes here>



Evaluating a Picture
IAAF Rule 164:
2. The athletes shall be placed in the order in which any part of their 
bodies (i.e. torso, as distinguished from the head, neck, arms, legs, 
hands or feet) reaches the vertical plane of the nearer edge of the finish 
line as defined above.

Or, in a picture…

Sounds
so simple!
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Evaluating a Picture
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Evaluating a Picture

• Primary Goal: Be consistent!
• If close, don’t be afraid to call it a tie.
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Other Tricks of the Trade

• Finishline Sheets – examples
• Splitting combined events (Varsity & FSB 

1600, etc.)
• Handling combined 3200 (all groups) 

using autocapture
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After The Race Is Over
• Congrats, You Survived!
• Figure out what worked, didn’t work.
• Go celebrate!


